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A. INTRODUCTION 
 
The primary purpose of this manual is to provide uniform standards regarding style and 
format, but also to allow enough flexibility to satisfy the accepted practices of each academic 
discipline. This manual serves as a guide to the University policies and procedures on the 
preparation of theses. 

 
Developing and writing a thesis is a significant task. No manual is likely to hold all the answers 
to questions that may arise. Faculty and students should feel free to contact the Office of 
Graduate Studies at graduatestudies@tamusa.edu about issues not addressed in the manual. 
 
 
B. CHOICE OF SUBJECT 

 
Selecting an appropriate thesis is one of the most significant aspects of graduate work. The 
topic should be the result of thoughtful consultation with the student’s Faculty 
Advisor/Program Coordinator. 

 
Once a topic has been approved by the Faculty Advisor/Program Coordinator for the 
department the student should submit a Committee Composition Approval Form to the 
Graduate Studies office. This should be done well in advance of when the student anticipates 
beginning work on the thesis but no later than the semester before the student anticipates 
graduation and completing the thesis. 
.  
Once this form has been submitted if there are any changes to your committee members you 
must submit a Change in Committee form to the Office of Graduate Studies before any further 
work can be done on your thesis. Forms should be submitted to graduatestudies@tamusa.edu. 

 
C. PROPOSALS PREPARATION AND SUBMISSION 

 
Theses require proposals. The thesis proposal should describe the research that the student 
intends to undertake. The proposal should explain the nature of the problem to be 
examined, the status of current research relating to the subject under consideration, the 
research method, and the importance of the projected work. The proposal will also contain 
a reference section, using an appropriate citation style for the student's designated major. 
The proposal will be submitted to the students’ Graduate Thesis Chair. 

D. CITATION AND WRITING STYLE: 

The style of theses vary widely according to academic discipline, yet there are standards 
common to all scholarship. The style of the thesis should be the decision of the student's 
graduate thesis chair, with the concurrence of the student's thesis committee and in line 
with any guidelines of his or her department. APA as the base formatting is required. 

 

 

mailto:graduatestudies@tamusa.edu
mailto:graduatestudies@tamusa.edu
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The Office of Graduate Studies guidelines for margins and formatting must be followed (see 
below). 

Thesis  
 The only exceptions in style and format are those articulated by the Office of  
Graduate Studies for: (1) all preliminary pages (Title Page, Approval Page, Abstract, 
 
Table of Contents, Table of Figures, Vita, etc.), and (2) margins and page numbering 
in the body of the text. The Office of Graduate Studies guidelines supersede 
guidelines which may be found in other journals and/or manuals. 

 
E. COPYRIGHT PROTECTION OF SOURCE MATERIALS 

 
Since a thesis is legally classified as a publication, care must be taken not to violate United 
States copyright laws. Inclusion of illustrative graphs, tables, charts, etc., from copyrighted 
sources is permitted only if a letter of release from the original copyright holder is included in 
a separate appendix of the thesis, and properly cited. In special cases where 
acknowledgement of source is sufficient, it should be clearly noted. 
 
F. THE USE OF HUMAN SUBJECTS IN RESEARCH 

 
It is the concern of Texas A&M University-San Antonio that no research sponsored by, 
supported by, or conducted by University faculty or students exposes persons who 
participate as subjects to unreasonable risks to health, general wellbeing, or privacy. 

 
Students' research projects which involve human subjects must be conducted in compliance 
with the University policy for protection of human subjects. Students planning such projects 
must consult their Graduate Thesis Chair about University regulations before they begin any 
research activities which involve human subjects. 

 
Students who wish to conduct research using human subjects in an effort to complete their 
thesis must seek approval from the Institutional Review Board (IRB). Further information 
about these regulations is available from the Office of Research and Graduate Studies at 
graduatestudies@tamusa.edu .  

 
 Research related to human subjects requires students to complete CITI training. Below is a 
link that you may use to access needed information for completing the CITI training.  

  
CITI Instructions: 
https://www.google.com/url?sa=t&rct=j&q=&esrc=s&source=web&cd=&cad=rja&uact=8&ve
d=2ahUKEwju6ID656HzAhUOFFkFHUniAp8QFnoECAMQAQ&url=http%3A%2F%2Fwww.tamu
sa.edu%2Facademics%2FOffice-Of-The-Provost%2FInstitutional-Review-Board%2FCITI-
Program-Instructions-2019.pdf&usg=AOvVaw01Dzp9cDr67dJ0fBQ7eIC_ 

 
G. THE USE OF ANIMAL SUBJECTS IN RESEARCH 

 

mailto:graduatestudies@tamusa.edu
https://www.google.com/url?sa=t&rct=j&q=&esrc=s&source=web&cd=&cad=rja&uact=8&ved=2ahUKEwju6ID656HzAhUOFFkFHUniAp8QFnoECAMQAQ&url=http%3A%2F%2Fwww.tamusa.edu%2Facademics%2FOffice-Of-The-Provost%2FInstitutional-Review-Board%2FCITI-Program-Instructions-2019.pdf&usg=AOvVaw01Dzp9cDr67dJ0fBQ7eIC_
https://www.google.com/url?sa=t&rct=j&q=&esrc=s&source=web&cd=&cad=rja&uact=8&ved=2ahUKEwju6ID656HzAhUOFFkFHUniAp8QFnoECAMQAQ&url=http%3A%2F%2Fwww.tamusa.edu%2Facademics%2FOffice-Of-The-Provost%2FInstitutional-Review-Board%2FCITI-Program-Instructions-2019.pdf&usg=AOvVaw01Dzp9cDr67dJ0fBQ7eIC_
https://www.google.com/url?sa=t&rct=j&q=&esrc=s&source=web&cd=&cad=rja&uact=8&ved=2ahUKEwju6ID656HzAhUOFFkFHUniAp8QFnoECAMQAQ&url=http%3A%2F%2Fwww.tamusa.edu%2Facademics%2FOffice-Of-The-Provost%2FInstitutional-Review-Board%2FCITI-Program-Instructions-2019.pdf&usg=AOvVaw01Dzp9cDr67dJ0fBQ7eIC_
https://www.google.com/url?sa=t&rct=j&q=&esrc=s&source=web&cd=&cad=rja&uact=8&ved=2ahUKEwju6ID656HzAhUOFFkFHUniAp8QFnoECAMQAQ&url=http%3A%2F%2Fwww.tamusa.edu%2Facademics%2FOffice-Of-The-Provost%2FInstitutional-Review-Board%2FCITI-Program-Instructions-2019.pdf&usg=AOvVaw01Dzp9cDr67dJ0fBQ7eIC_
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Texas A&M University-San Antonio takes responsibility for humane care and treatment of 
animals used in research projects. The university is committed to complying with the laws for 
Use of Animals for research, the Guide for the Care and Use of Laboratory Animals, the 
provisions of the Animal Welfare Acts, and other applicable laws and regulations. 

 
In planning research projects that involve animal subjects, students should consult the 
appropriate published guides for the care and use of laboratory or experimental animals. 
Such information may be accessed through the link listed below. 
 
https://www.tamusa.edu/graduate-studies-research/research/institutional-animal-use-care-
committee/index.html 
 
H. Institutional Biosafety Committee 

 
All research conducted by Texas A&M University-San Antonio employees or students, 
involving any of the agents/materials listed in the FAQs (link listed below), must be 
approved by the Texas A&M University-San Antonio Institutional Biosafety Committee 
(IBC) prior to initiation of the research.  
 
https://www.tamusa.edu/graduate-studies-research/research/institutional-biosafety-
committee/faqs.html 

 
Before starting work with rDNA or biohazardous materials, registration with the Institutional 
Biosafety Committee is required. Depending on the nature of the proposed research, approval 
may also be required by the  IACUC, and IRB. 

 
I. MANUSCRIPT PREPARATION 

 
i. Corrections 

The final draft of the thesis must not contain any visible corrections (e.g., crossing out 
of letters or words, use of white-out). 

ii. Reproduction of Manuscripts 
Xerography, offset, and clear originals produced by a laser printer (or printer that 
produces equivalent quality output) are the only acceptable methods of reproducing 
copies of theses. Only one method may be used to produce the final copies; mixing 
different types of reproduction is not acceptable. 

iii. Paper Quality and Signatures 
All copies of the theses must be on high quality white paper. It is the duty of the 
student to secure original signatures for each copy of the thesis. All signatures must 
be in black or blue ink. Electronic signatures are acceptable. 
 

iv. Photographs 
Photographs included in the manuscript must be properly labeled and cited. 
Output produced by any printer is acceptable if the type meets the usual type 
requirements. Photocopies of the original document are acceptable for final 

https://www.tamusa.edu/graduate-studies-research/research/institutional-animal-use-care-committee/index.html
https://www.tamusa.edu/graduate-studies-research/research/institutional-animal-use-care-committee/index.html
https://www.tamusa.edu/graduate-studies-research/research/institutional-biosafety-committee/faqs.html
https://www.tamusa.edu/graduate-studies-research/research/institutional-biosafety-committee/faqs.html
https://researchservices.cornell.edu/offices/IRB
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copies of the thesis, provided the copies are of high quality. 
v. Oversized Illustrative Materials 

Oversized materials include, for example, large maps or charts which cannot be 
reduced and yet must be folded to fit onto an 8 ½ by 11 sheet of paper. All oversized 
materials must be identified in the text. The student's name and month/ year of 
graduation (for further identification) must be displayed in such a way that the 
information can be read while the material is folded. 

vi. Reductions 
Reduction of tables, charts, figures, etc., must be large enough to be easily legible. The 
minimum size for numbers and capital letters is 1.5 millimeters (0.06 inches). 

vii. Facing Page Captions 
Captions or titles on a facing page are to be used only when absolutely necessary. 
Facing page captions may be used for figures only, never for tables. This exception 
applies only when the caption cannot be printed directly on the page on which the 
figure appears, or when there is no room on the List of Figures page for a caption to 
be typed within the margins. These are the only instances in which printing is 
permitted on the back side of a page of a thesis. 

If a facing page caption is necessary, the page must face in the normal manner. Only 
the page number appears on the front side of the page. The caption itself is printed on 
the back side of the page containing the page number. This caption must fall within 
the required margins. 

The facing page and the List of Figures page are both consecutively numbered, with 
the page numbers in the standard position. On the List of Figures page, the number of 
the page on which the figure itself appears is the only number that is recorded. 

viii. Tables and Figures 
Presentation of tables and figures referred to in the text should follow their first 
mention as soon as feasible. A short table or small figure may be placed on the text 
page itself, in which case the table or figure should be separated from the text by 
triple spacing at the top and bottom. A full-page table or figure should be placed on 
the page following the first reference to it. Subsequent references to a given table or 
figure should include the page number in parenthesis. 

Each table or figure in the main body of the graduate research project and/or thesis 
must have a separate number and a title. These must be entered in the List of Tables 
page or the List of Figures page. The numbering, wording, and pagination of titles and 
headings must be the same size, style, and font as on the thesis. Tables and Figures 
are to be numbered consecutively throughout the graduate research project and/or 
thesis. A List of Figures page or a List of Tables page is not necessary if the graduate 
research project and/or thesis contains only one figure or table. 

Titles should be concise but should also clearly describe the content of the table or 
figure. No two titles should be identical in wording. Placement of titles should follow 
the style and format of the journal which is being used as a model for the graduate 
research project and/or thesis. 
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If tables or figures must be placed lengthwise or broadside, the top of the table or 
figure should be at the left-hand, binding side of the page. The caption should be at 
either the top or the bottom of the table or figure, not at the bottom of the page. 
 

Tables longer than one page in length should have the complete title and table 
number on the first page only. Subsequent pages of the same table should have the 
table number and the word "Continued," plus the necessary column headings for ease 
of reading and reference. 

 
I. FORMAT 

 
a. Typeface Specifications 

Theses should be written in a conventional font, approved by the committee chair 
(e.g., Arial, Verdana, Times New Roman).The type size must be 12 point. 

b. Line Spacing 
Line-spacing of the narrative text may be 1 1/2 spaces or double spaced. Mixing spacing 
is not acceptable. Single spacing is used only for such specific and appropriate purposes 
as  
long, blocked, and inset quotations, footnotes, endnotes, and itemized or tabular 
materials. 

c. Margins 
All typing must be 1 1/2 inches on the left, 1 inch on the right, and a minimum of 1 
inch on the top and bottom of each page, except for the page number, which is placed 
one-half inch from top of the page and even with right-hand margin. 
All illustrations and tables in the thesis must conform to the margin requirements in 
every way. 

d. Pagination 
Every page in the thesis except the Title page and the Approval page must be 
numbered. The Title page is considered to be page i and the Approval page is 
considered page ii, but no pagination numeral is shown on these two pages. 

 
All page numbers [except those of the preliminary pages and the first page of each 
major section within the body of the manuscript] must be placed in the upper right-
hand corner of the paper about one-half inch below the top edge of the paper and 
even with the right- hand margin. 
 
Preliminary pages: Lower case Roman numerals (iii, iv, v, vi, etc.) are used to number 
the preliminary pages. These pages are numbered at the bottom center of the page. 
The first numbered page is the Abstract page (iii). 

 
Text and Supplementary pages: Arabic numerals are used in numbering all text and 
supplementary pages. The first page of the narrative text begins with the number 1, at 
the top right corner, and the numbering runs consecutively to the end of the thesis. 
 
Vita page: The VITA page carries the last page number in the thesis, with the page 



10 | P a g e   

number shown at the top, right corner. 
 
J. REQUIRED PARTS OF THE MANUSCRIPT 

 
a. Title Page 

The Title Page for thesis must follow the style, spacing, and form of the example 
shown in APPENDIX A. 

 
Checklist: 

i. The title is typed in capital letters, double spaced (if the title is more than one line in 
length), and centered within margins. 

ii. There is no page number on the Title page (although it is considered to be page i). 
iii. The full legal name of the student typed in capital letters, without initials and without 

designation of profession, military rank, or marriage is listed. The name on the thesis 
must be the same as that recorded in the official records of the Registrar of Texas A&M 
University-San Antonio. Any changes must be cleared by both the Registrar and the 
Office of Graduate Studies, as well as the student's Thesis Committee. 

iv. The appropriate month and year when the degree will be awarded must be shown at 
the bottom of the Title page. 

b. Approval Page 
Each copy of the graduate thesis must have an Approval Form with original signatures of 
all members of the Thesis Committee, Graduate Thesis Chair, the Department Chair (or 
his or her authorized representative), and the Office of Graduate Studies. The student 
should check with the Office of Graduate Studies if there is any question about 
authorized signatures. 

 
Signatures must be in black or blue ink and no signature should appear more than once 
on the Approval Form. Electronic signature are acceptable.  

 
The number of signature spaces on the page is determined by the number of members 
on the student's Thesis committee. The name of each member on the committee must be 
typed under each signature space. The academic rank of each member on the committee 
must be indicated in parentheses under each signature space. 
 
Checklist 

 

i. The title of the project is typed in capital letters, double-spaced (if more than one 
line in length), and centered within the margin. The title on the Approval page must 
be exactly the same as the title on the title page. 

ii. There is no page number on the Approval page (although it is considered to be page 
2.) 

 
iii. The full legal name of the student, typed in capital letters, without initials and 

without designation of profession, military rank, or marriage is listed. The name on 
the thesis should be the same as that recorded in the official records of the 
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Registrar of Texas A&M University-San Antonio. Any changes must be cleared by 
both the Registrar and the Office of Graduate Studies, as well as the student's 
Thesis Committee. 

 
iv. If the student has a Co-Chair, the status of each is listed as “Co- Chairperson of 

Committee”; neither is designated as “Chairperson of Committee.” 
 

v. If the Head of the student's major department serves also as a member or as        
Chairperson or Co-Chairperson of the student's Thesis Committee, he or she must  
 sign only once in the signature space allotted under “Chairperson of Committee and 

                Department Head.” 
vi.   The appropriate month and year when the degree will be awarded must be shown at 

 the bottom of the Approval page. 
 
c. Abstract 

The Abstract Page must follow the style, spacing, and form of the example. The Abstract, 
which is placed immediately after the Approval page, is the first numbered page, iii, 
centered at the bottom of the page. The text of the Abstract must not exceed 150 words. 

 

Checklist 
 

i. Numbering of pages starts with the Abstract page (iii), centered at the bottom of 
the page. 

ii. The word ABSTRACT is centered at the top of the page within the margins and is 
typed in capital letters. 

iii. The title of the graduate thesis is typed three spaces below the word ABSTRACT in 
upper and lower case letters and double-spaced (if more than one line in length). 
The title on the Abstract must be exactly the same as the title on the Title and 
Approval pages. 

iv. The date of graduation (same date as shown on the Title page and the Approval 
page) must be shown on the Abstract page. It is placed in parentheses (double 
spaced) below the title. 

v. The student's full legal name, as listed on the Title and Approval pages and his 
previous degrees are listed one double line space beneath the date of 
graduation. 

vi. The name of the Chairperson, or the names of the Co-Chair of the student's 
Advisory Committee, are listed one double space beneath the last line designating 
the student's previous degree(s). 
Example: Co-Chair of Advisory Committee: Dr. John Wilson, Dr. Harry Smith 

vii. For the graduate research project the student will name the: 
Example: Graduate Research Advisor: Dr. Katherine Gillen 

viii. The text of the Abstract starts one triple line space beneath the heading with 
a paragraph indentation. The Abstract text is typed double line spaced and is 
consistent with the spacing style followed in the narrative text. 
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d. Dedication 

Font paragraph will be italicized, and indented to the left.  
 

e. Acknowledgments 
Font paragraph will be italicized, and indented to the left. 
 

f. Table of Contents 
The Table of Contents indicates the major divisions (i.e., chapters or sections) and 
principal subheadings of the thesis. 
 
Preliminary pages do not have to be listed in the Table of Contents; however, if they are 
listed, the listings must start with the Abstract (iii) and must include all preliminary pages. 

 
Inclusion of the Table of Contents page, in the Table of Contents itself is optional. 

 
All major divisions of the narrative text (i.e., chapters or sections) and principal 
subheadings (when appropriate) within each chapter or section must be listed in the 
Table of Contents. The subordination of the subheadings should be indicated by 
appropriate spacing and indentation. 

 
All supplementary pages such as the reference section, appendices (if any), and Vita must 
be listed in the Table of Contents. 

 
The numbering, wording, and pagination of titles and headings must be exactly the same 
in the Table of Contents as they are on the pages of the graduate thesis. All page 
numbers of the Table of Contents are right-hand justified. 

 
g. Vita 

A brief biographical sketch of the student is required as a part of each manuscript. This 
biographical sketch is called a VITA, and it may exceed one page in length. 

 
The title, VITA, is typed in capital letters and centered at the top of the first page. 

 
The vita is the last numbered section in the graduate thesis and must be included in the 
Table of Contents. It is numbered at the top right edge. 

 
The biographical sketch should include the student's full legal name (as it appears on the 
title page and elsewhere), contact information (mailing address, email address, and phone 
number), and educational background (including schools attended, degrees, where 
completed, and major field of specialization, conference presentations, publications). 
Where applicable, the vita should list professional experience in industry, military 
service, business, and academic life, as well as any publications or conference 
presentations. 
 

K. DIVISIONS OF NARRATIVE TEXT 
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The narrative text may be divided into chapters or sections. The journal model or 
the conventional style of the student’s academic discipline can help determine 
which style is most appropriate. 

 
a. Chapters 

Chapters are designated both by upper case Roman numerals used consecutively 
throughout the thesis and by a chapter title. The chapter designation (i.e., CHAPTER 
I) in capitals should be centered within the margins at the top of the page. The 
chapter title also appears in all capitals and is centered and double- spaced below 
the chapter designation. All chapter titles of more than one line in length should be 
double-spaced. 
Each chapter or section begins on a new page. The title of the chapter or section is 
typed in capital letters and is centered at the top of the page. 

 

b. Section 
Section titles need not be numbered but are typed in capital letters. Section titles of 
more than one line in length should be double-spaced. Subdivisions within chapters 
or sections do not begin on a new page. Subdivision headings are typed in upper and 
lower case letters and may be either centered or flush left. 

 
L. REFERENCING AND APPENDICES 

 
References should be consistent in following the chosen citation style. 

 
If the student wishes to list general references consulted and used as background 
study, these may be listed in a separate subdivision of the References section. 
Background materials listed should follow the chosen citation style. 

Some departments encourage the use of an Appendix for such items as raw data, 
problems encountered, and other information. Appendices may be added to the end 
of a graduate thesis and/or research project; format and style are left up to the 
Program Chair or Graduate Thesis Chair. 

 
M. GENERAL CHECKLIST FOR FINAL DOCUMENTS 

 
a. General neatness and readability. 
b. Quality of reproduction. 
c. Consistency of style and format throughout the document. 
d. Title page, Approval page, Abstract page, Dedication page, Acknowledgement page, 

and Vita page, including: 
i. Style, spacing, and format. 

ii. The month and year of graduation. 
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iii. Full legal name of the student, without initials and without designation of 
profession, military rank, or marriage. The name on the thesis should be the 
same as that recorded in the official records of Texas A&M University-San 
Antonio. Any exceptions must be cleared by both the Registrar and the Director 
of the Office of Research and Graduate Studies, as well as the Student’s 
Graduate Research Chair or Advisory Committee. 

iv. Double-spacing of titles over one line in length. 
v. Original signatures (in black or blue ink) of all members of the student’s 

Advisory Committee and Head of Department on all copies of the Approval 
page. 

 
e. Exact correspondence of titles and page numbers of items in the Table of 

Contents, List of Tables, and List of Figures with the same titles and page 
numbers in the text. 

 
f. Format and spacing of appropriate sections within the manuscript, including: 

i. Major divisions: Each major division (e.g., Abstract, Dedication, 
Acknowledgments, Table of Contents, List of Figures, Symbols, References, 
Vita, etc.) is typed in capital letters and centered at the top of a new page. Each 
chapter or section heading or title is also a major division which is typed in 
capital letters and centered at the top of a new page. Page number appears at 
the bottom center of the page. 

ii. Subheadings: There must be consistent subordination of subheadings 
within each chapter or section. Subheadings are the further division within 
each chapter or section and do not start on new pages and are not typed in 
all capital letters. The standard placement of subheadings is either flush left 
or centered. 

iii. Table of Contents: Major division and principal (or first-order) subheadings 
must be listed on the Table of Contents page. The page number for the Table 
of Contents is centered at the bottom of the page. 

 
g.   Appropriate format and placement of figures and tables within the manuscript. 
h. Consecutive numbering of tables and figures throughout the manuscript. 
i. Consistent citation style. 
j.   Compliance with margin requirements. 
k.   No liquid paper or visible corrections on copies submitted. 
l.   Numbering of every page in the manuscript starting with Abstract page (iii) and 

ending with the Vita page. 
m. Proofread for correct grammar and spelling. 

 
N. SUBMISSION OF GRADUATE RESEACH PROJECTS AND THESIS PACKAGES 

 
The final graduate thesis are submitted to the Office of Research and Graduate Studies by 
email at graduatestudies@tamusa.edu on or before the published deadline. 
 
Submission of graduate thesis should contain all required parts of the manuscript. 

 
The thesis package becomes the property of the University and is archived in the University 
Library. 

 

mailto:graduatestudies@tamusa.edu
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APPENDIX A 
 

Sample Title Page for Theses 
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      WHEN AN ANDROID DOESN’T KNOW HE’S AN ANDRIOD: 
{double spaced 

HOW CAN “IT” NOT KNOW WHAT “IT” IS? 
 
 
 
 
 
 
 

 
A Thesis 

by 

JAMES F. SEBASTION 

{6 spaces 
 

{Double spaced 
 

{Double spaced 

 
 
 
 
 
 
 

{6 spaces single spaced 
Submitted to Office of Graduate Studies  

Texas A & M University-San Antonio {center this section 
in partial fulfillment of the requirements for the degree of 

 
 

{6 single spaces 
 
 

MASTER OF ARTS 
 
 
 

{4 spaces 
             December 2021 {Semester of Commencement 

 
 

{4 spaces 
 

Major Subject: English Literature 



17 | P a g e   
 
 
 
 
 
 
 
 
 
 
 
 
 

APPENDIX B 
 
 

Sample Title Page for Graduate Research Projects 



18 | P a g e   
 

     THE DEVELOPMENT AND IMPROVEMENT OF INSTRUCTION 
{Double space 

FOR GRADUATE STUDENTS 
{6 single spaces 

 
 
 
 
 

A Graduate Thesis 

by 

JOHN PHILIP SMITHERS 

 

{Double spaces 
 

{Double spaced 
 

{6 single spaces 

 
 
 
 
 

Submitted to Office of Graduate Studies  
    Texas A&M University-San Antonio {single space, centered 

in partial fulfillment of the requirements for the degree of 
 

{6 single spaces 
 
 
 

 
MASTER OF SCIENCE 

{4 single spaces 
 
 
 

                                                                   December 2021                   {Semester of Commencement 
 
 
 

{4 single spaces 
Major Subject: Educational Administration 

 
 
 
 
 

19 



19 | P a g e   
 
 
 
 
 
 
 
 
 
 
 
 
 

APPENDIX C 
 

Sample Thesis Approval Page 



20 | P a g e   
 

WHEN AN ANDROID DOESN’T KNOW HE’S AN ANDRIOD: 
 

HOW CAN “IT” NOT KNOW WHAT “IT” IS? 

 

{Double space 

{6 single spaces 
 
 
 

 
A Thesis 

by 

JAMES F. SEBASTION 

 
{Double space 

 
{Double space 

 
{4 single spaces 

 
 
 

Approved as to style and content by: 
{4 single spaces 

 
 
 
 
 

          Hampton Francher, Ph. D.                                 David W. Peoples, Ph.D. 
          Assistant Professor    Associate Professor 
         (Chair of Committee)   (Committee Member) 

{4 single spaces 
 
 
        M Emmett Walsh, Ph.D.                                      Eldon Tyrell, Ph.D. 
         Associate Professor                                             Professor  
        (Committee Member)                                         (Committee Member) 

{4 single spaces 
 
 
 
 
 

Vijay Golla, Ph.D. 
(Vice Provost for Research and Graduate Studies) 

 
 

         MONTH YEAR                 {Semester of commencement 



18 | P a g e   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

APPENDIX D 
 

Sample Graduate Research Project Approval Page 



19 | P a g e   
 

FACE TOUCHING DURING IN-VIVO VERSUS VIDEO CONVERSATIONS BY 
{Double space 

SAME AND OPPOSITE SEX DYADS 
 

{6 single spaces 
 
 
 

 
         A Graduate Thesis 

 

{Double space 
By 

 

{Double space 
JOANNA V. CASKEY 

 
 

{4 single spaces 
 
 

Approved as to style and content by: 
{4single spaces 

 
 
 
 

 
 

   Robert R. West, Ph.D.  
   Assistant Professor 
   (Committee Chair) 

 
 

      Adrienne Shelly, Ph.D.  
      Associate Professor 
      (Committee Member) 

 
 
 
 

 

Vijay Golla, Ph.D. 
(Vice Provost for Research and Graduate Studies) 

 
MONTH YEAR                  {Semester of Commencement 



20 | P a g e   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

APPENDIX E 
 

Sample Abstract Format for Theses 



21 | P a g e   
 

ABSTRACT 
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Month and year of} (Month Year) 
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text of the Abstract must not exceed 150 words (graduate research project and thesis). This is 

the first page to have a lower-case Roman numeral (iii) centered at the bottom of the page. 
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text of the Abstract must not exceed 150 words (graduate research project and thesis). This is 

the first page to have a lower-case Roman numeral (iii) centered at the bottom of the page. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
(Under name include only degrees already held, not the one that will be awarded) 



24 | P a g e   
 
 
 
 
 
 
 
 
 
 
 

APPENDIX G 
 

Sample Formats, Table of Contents 



25 | P a g e   
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ABSTRACT .................................................................................................................................... iii 

ACKNOWLEDGMENT .................................................................................................................... iv 

TABLE OF CONTENTS .................................................................................................................... v 

LIST OF FIGURES ........................................................................................................................... ix 
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Mechanics .......................................................................................................................... 3 

Thermodynamics ............................................................................................................... 5 

Constitution ...................................................................................................................... 8 

Problem Summary ........................................................................................................... 14 

VITA .............................................................................................................................................. 25 
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CHAPTER Page 
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Constitution ...................................................................................................................... 8 
Problem Summary ............................................................................................................ 14 

III. SOLUTION ALTERNATIVES ................................................................................................. 15 

VITA .......................................................................................................................................... 25 
 
 
 
 
(Note: The Tables of Contents must include a VITA in either case) 
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CHAPTER I. INTRODUCTION ............................................................................................................ 1 

First-Level Subheading ............................................................................................................... 1 
First-Level Subheading ............................................................................................................... 3 

Second-Level Subheading ................................................................................................. 4 
Second-Level Subheading (If Headings Are Long, 
Indent Runover Lines) ....................................................................................................... 6 
Second-Level Subheading ................................................................................................. 9 

Third-Level Subheading .............................................................................................................. 10 

First-Level Subheading ................................................................................................................. 12 

CHAPTER II. PROBLEM IDENTIFICATION ...................................................................................... 14 

[Continue as necessary] 

REFERENCES .................................................................................................................................. 78 

APPENDIX A. TITLE OF APPENDIX ................................................................................................. 80 

APPENDIX B. TITLE OF SECOND APPENDIX .................................................................................. 90 

VITA ............................................................................................................................................. 100 
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Sample E: Decimal Heading 
TABLE OF CONTENTS 

Page 
ABSTRACT ............................................................................................................................. iii 

ACKNOWLEDGMENT ............................................................................................................. iv 

TABLE OF CONTENTS .............................................................................................................. v 

LIST OF FIGURES ..................................................................................................................... ix 

LIST OF TABLES ........................................................................................................................ x 

CHAPTER I. INTRODUCTION .................................................................................................... 1 

1.1. First-Level Subheading ..................................................................................................... 1 
1.2. First-Level Subheading ..................................................................................................... 3 

1.2.1. Second-Level Subheading ............................................................................................. 4 

1.2.2. Second-Level Subheading (If Headings Are Long, 
Indent Run-over Lines) ............................................................................................................. 6 

1.2.3. Second-Level Subheading ............................................................................................. 9 

1.2.3.1. Third-Level Subheading (Again, If Headings Are Long, 
Indent Runovers) ................................................................................................................... 10 

1.2.3.2. Third-Level Subheading ............................................................................................. 11 

1.3. First-Level Subheading ................................................................................................... 12 

CHAPTER II. PROBLEM IDENTIFICATION ............................................................................... 14 

[continue as necessary] 

REFERENCES .......................................................................................................................... 78 

APPENDIX A. TITLE OF APPENDIX .......................................................................................... 80 

APPENDIX B. TITLE OF SECOND APPENDIX ........................................................................... 90 

B.1. First-Level Subheading ................................................................................................... 91 
B.2. First Level Subheading ................................................................................................... 92 

VITA ...................................................................................................................................... 100 
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To: Names (Thesis Committee 
Members) and Department Faculty 

 
From: Name  (Chair of Committee) 

Date: 

Re: Thesis Presentation by (Student's Name) 
 
 

(Student's name) will present and defend his/her thesis on (day, date, time, and where). 
 

The title of his/her thesis is "  ." You are 
cordially invited to attend his/her presentation. 

 
 
cc: Department Chair 
Dean of the College 
Vice Provost for Research and Graduate Studies 
Provost 
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Plagiarism 

 
Plagiarism is defined as "a piece of writing that has been copied from someone else and is 

presented as being your own work." [1] Three simple conventions have been developed to 
identify when a writer must provide a reference. [2] 

1. If you use someone else's ideas, you should cite the source. 

2. If the way in which you are using the source is unclear, make it clear. 

3. If you received specific help from someone in writing the paper, acknowledge it. 

 
Types of Plagiarism 

 
• Complete Plagiarism: This is the most obvious case: a student submits, as his or her own 
work, an essay that has been written by someone else. 
• Near-complete Plagiarism: A student may also lift portions of another text and use them in 
his or her own work. 
• Patchwork Plagiarism: In many cases, a student will lift ideas, phrases, sentences, 
and paragraphs from a variety of sources and "stitch" them together into an essay. 
• Lazy Plagiarism: Inadvertent use of another's language, usually when the student fails 
to distinguish between direct quotes and general observations when taking notes. 
• Self-Plagiarism: The use of an essay written for one course to satisfy the requirements of 
another course is plagiarism. Students should not use, adapt, or update an essay written 
for another purpose [3]. 

 
 
AVOIDING PLAGIARISM 

To avoid plagiarism, all students must document sources properly using Footnotes, 
Endnotes, or Parenthetical References, and must write a Bibliography, References, or Works 
Cited page and place it at the end of the research paper to list the sources used. [4]. 



34 | P a g e   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Appendix J 
 

Formatting Page Numbers in a Word Document 



35 | P a g e   
 

Format Page Numbering in Word 2016, 2018, 2019: 
 
 

1. Click at the very beginning of the first page where you want to start, stop, or change 
page numbering. 

2. Choose Layout (or Page Layout) > Breaks > Next Page. 
3. On the page after the section break, double-click in the header (top of page) or 

footer (bottom of page) area where you want to display page numbers. This will 
open the Design tab under Header & Footer Tools. 

4. Click Link to Previous to deselect the button and disconnect your header or footer 
from the header or footer in the previous section. 

5. In the Header & Footer group, click Page Number, pick a location, and then choose 
a style in the gallery. 

6. To choose a format or to control the starting number, in the Header & Footer group, 
choose Page Number > Format Page Numbers to open the Page Number Format 
dialog box. 

7. Do either or both of the following: 
a. Click Number format to select the format for the numbering, such as a, b, c or i, 

ii, iii. 
b. Under Page numbering, choose Start at and type a number that you want to 

start the section with. 
8. When you’re done, choose the Close Header and Footer, or double-click 

anywhere outside the header or footer area to close it. 
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Format Page Number in Word 2010 and 2007: 

 
1. Click between two parts of your document that you want to number differently. 
2. On the Page Layout Tab, Click Breaks. 
3. Click Next Page, Even Page, or Odd Page, and then click OK. 
4. Click in the first section of your document. 
5. On the Insert Tab Click Header and then Click Edit Header 
6. Click in the header or footer where you want the page number 
7. On the Header & Footer Tools tab Click Page Number 
8. Click The option that puts the page number where you would like 
9. On the Header & Footer Tolls tab Click Page Number 
10. Click Format Page numbers 
11. In the Number Format box, click the format that you want for the numbers in this section. 
12. Do one of the following: 

a. If you want the page numbering for the first page in this section to start at a 
particular number other than the first number in the format series, click Start at 
under Page numbering, and then enter the first number that you want to 
appear on the first page of the section. 

b. If you want the page numbering to continue from the previous section, 
click Continue from previous section. 

13. Click OK 
14. On the Header and Footer tools tab, click Next in the Navigation Group 
15. Repeat steps 1 through 3 and 9 through 11 to change the page numbering for 

another section 
16. On the Header and Footer tools tab, click Close. 
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Format Page Numbering in Word 2003: 
 

1. Click between two parts of your document that you want to number differently. 
2. On the Insert menu, click Break. 
3. Click Next Page, Even Page, or Odd Page, and then click OK. 
4. For Help on an option, click the question mark, and then click the option. 
5. Click in the first section. 
6. On the View menu, click Header and Footer. 
7. Click in the header or footer where you want the page number. 
8. On the Header and Footer toolbar, click Insert Page Number 
9. On the Header and Footer toolbar, click Format Page Number. 
10. In the Number format box, click the format that you want for the numbers in this section. 
11. Do one of the following: 

a. If you want the page numbering for the first page in this section to start at a 
particular number other than the first number in the format series, click Start at 
under Page numbering, and then enter the first number that you want to 
appear on the first page of the section. 

b. If you want the page numbering to continue from the previous section, 
click Continue from previous section. 

12. Click OK. 
13. On the Header and Footer toolbar, click Show Next. 
14. Repeat steps 1 through 3 and 8 through 11 to change the formatting of the 

page numbering for another section. 
15. On the Header and Footer toolbar, click Close. 
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